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RELEASE NOTES
Mackie Digital X Bus X.200 Software Update • June 5, 2006

Build 1.2

These release notes describe changes and fixes that have 
been made in the Digital X Bus X.200 software since 
Build 1.1.037.

MANUALS
The Digital X Bus X.200 Quick-Start Guide and X.200 
Owner's Manual are posted on the web site as PDF 
downloads. Adobe Acrobat Reader is available from Ado-
be’s web site to read the PDF documents.

SOFTWARE INSTALLATION
New software releases can be downloaded from Mackie’s 
web site by going to the Digital X Bus Product section 
and clicking “Software Update.” Installation instruc-
tions for Windows and Macintosh platforms can also be 
downloaded there.  If you don't know the software ver-
sion you are currently using, you can check your software 
version and build number by clicking Windows > About 
in the Digital X Bus menu bar.

RELEASE NOTES FOR BUILD 1.2 

New Features for BUILD 1.2
•	 Events 

The Events feature implements true snapshot (or 
“scene”) automation into the Digital X Bus. An Event 
is simply a Snapshot that can be recalled from within 
the Mix Editor during Automation playback. To cre-
ate a new Event, simply locate to a time in the Mix 
Editor where you want to place the Event, then select 
“New” from the Events window (Windows > Events). 
When the New Event dialog appears, you can choose 
which Snapshot you wish to use from the list. Once 
created, the Event appears in the Mix Editor as a blue 
marker, and can be dragged to a different time exactly 
as locate markers can. In the Events Window you can 
also edit, delete, renumber and add descriptive text to 
Events.

	 Event recall works in parallel with the console auto-
mation system, but is not a part of the automation 
system. Therefore the Events are not controlled or 
affected by any of the Automation Window settings 
(Windows > Automation) or any control surface Auto-
mation buttons. Whenever a potential conflict occurs, 
Automation always takes precedence over Events on 
a control-by-control basis. For example, if a channel 
fader is automated, and the channel is in Automation 
Read mode, that channel will always follow the Auto-
mation Track even if an Event would otherwise try and 
change the fader value. If the channel is taken out of 
Automation Read or the fader has no corresponding 
automation data, then the fader will follow the Event.

•	 Improved Reduction Metering (Compressor) 
The resolution of the compressor reduction meter in 
the Dynamics Window (Windows > Dynamics) has 
changed to allow for better visibility into compressor 
activity in the critical 0 to –12 dB reduction range, thus 
helping users to make better decisions about setting 
compressor controls. The reduction meter has been 
moved to the right of the input and output meters 
because it now has different scaling.

•	 Set Plug-in Delay 
The “Set Plug-in Delay” function in the Channel Menu 
replaces the previous “Adjust Channel Delay” feature, 
which required the user to do manual Channel Delay 
offset calculations to set up multiple channels with 
different delay offsets. The Set Plug-In Delay feature 
now accounts for differing delay offsets across all 
channels, so that the user only needs to enter the 
total delay of all plug-ins inserted into the selected 
channel(s), and all channels in the console are cor-
rected accordingly. Additionally, Set Plug-in Delay sets 
the Channel Delays to the minimum values required 
to maintain the relative offsets of all channels, thus 
preventing the accumulation of unnecessary delay 
and dramatically improving the latency and plug-in 
delay management in the Digital X Bus.

	 As an example, let’s say that you have a VST Plug-in 
with 20 ms of delay inserted in Channel 1, another 
with 40 ms of delay in Channel 2, and two VST 
Plug-ins with 50 ms total delay in Channel 3. To com-
pensate for these Plug-in delays, first select a channel, 
then choose the Set Plug-in Delay function and enter 
the Plug-in Delay for that channel; then do this for the 
other two channels. When you are finished, the delays 
for each channel will be 30 ms, 10 ms, 0 ms, and 50 ms 
(for channels 4 and up), respectively. To compensate 
for the removal of a Plug-in, use the Reset Plug-in De-
lay feature, or enter a “0 ms” delay in the Set Plug-in 
Delay feature.

•	 Channel Naming “TAB” Shortcut 
To speed up channel naming you can now use the 
Tab button on your attached QWERTY keyboard to 
tab between Channel Names in the channel strip. 
Additionally, pressing Enter after editing a channel 
name will now set the name and exit the field (previ-
ously you had to click outside the name box to set the 
name). This is a direct feature carry-over from the d8b 
and a real time saver when setting up new sessions.

•	 Automation on Linked Channels 
It is now possible to automate Stereo-Linked Chan-
nels using only a single Automation Track. When two 
channels are linked, but only one is automated, then 
the linked controls of the non-automated channel 
will follow the Automation Track(s) of the automated 
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channel. Automation always takes precedence over 
linking for those controls on each channel that are 
automated. For example, if the EQs and Dynamics of 
Channels 1 and 2 are linked, and the EQs and Dynam-
ics of Channel 1 are both automated but only the 
Dynamics of Channel 2 are automated, then when 
both channels are placed in Read mode, Channel 2’s 
EQs will follow Channel 1’s automation, but Channel 
2’s Dynamics will follow Channel 2’s automation.

•	 Channel Presets available for all Channels 
Channel Presets can now be saved from and loaded 
into all types of channels (except DAW channels), 
whereas previously they were available for only Chan-
nels 1-72. Presets are also cross compatible between 
the different channel types, so that when a Preset is 
saved from a channel of one type and loaded into a 
channel of another, those controls common to both 
will be loaded correctly. For example, the EQ, Dynam-
ics, Fader Level, and Mute settings of a Preset saved 
from Channel 1 will correctly load into Aux 8. The 
Channel Presets dialog now indicates when Aux, Bus, 
Mix, Group, or MIDI channels are selected.

•	 Direct Outputs 
In version 1.1 and earlier, whenever you routed a 
“Channel” Direct Output to a physical output from 
within a Card I/O dialog, the Channel’s Direct Out 
Level control had no effect on the signal, and the route 
fails to appear in the Channel’s Assigns window and 
Channel Strip Direct Out routing menu. Conversely, 
when you did the same from within the Assigns win-
dow or Channel Strip, the Direct Out Level control did 
affect the signal level, and the route appeared in the 
Assigns window and Channel Strip.

	 These discrepancies have been reconciled. Channel 
Out assignments are now always affected by the Di-
rect Out Level control, and the output routes always 
appear in the Assigns window and Channel Strip rout-
ing menu. It is now possible to create multiple output 
assignments from with the Assigns window and 
Channel Strip, simply by selecting additional routes. 
When a Channel output is assigned to more than one 
physical output, the routing box says “Multiple”.

	 Additionally, the Aux, Bus, and Mix Channels now have 
Direct Out assignment menus so that you no longer 
need to go to the Card I/O dialogs to make Direct Out 
assignments from these channels. However, there is 
no Direct Out Level control for these channels because 
the outputs are always post-fader. Routing from a 
channel output to the input of another channel or 
Phones mix remains unaffected by these changes; the 
Direct Out Level control has no effect on the levels, 
and the routes do not appear in the source Channel’s 
Assigns window or Channel Strip routing menus.

•	 Assign to Buses 
The “Assign to Buses” feature replaces the “Copy Mix 
to Bus” function in the Edit menu. While similar in 
function to its predecessor, the Assign to Bus function 
is simpler to use and requires fewer steps to achieve 
the same result. The Assign to Buses dialog contains a 
set of Bus Assign buttons identical to those found in 

the Channel Assigns window. Bus Assignments made 
in the Assign to Bus dialog are applied to all selected 
channels.

•	 Inverse Aux Panning 
Whenever the Auxes of two channels are linked, the 
Aux Pan controls for any Stereo Auxiliaries will pan in-
versely whenever the “Pan Inversely” setting is linked.

•	 Input to Bank and Bank to Output 
For consistency, the Route to Bank function has been 
renamed to Input to Bank, and new functionality has 
been added to both the Input to Bank and Bank to 
Outputs commands. Normally, these commands are 
used to route a defined block of 24 physical inputs 
or outputs to/from the channels in the active Bank. 
However, because of the Channel Patching feature, 
the layout of the channels in the Bank can be changed 
from the default order (for example, Channels 1-24 
from left to right in Bank 1-24).  Now, whenever the 
channel layout differs from the default, you are pre-
sented with the option either to route to/from the 
channels in the default order and layout for that Bank, 
or to route to/from the channels according to the 
current layout. For example, if Channels 55 and 56 are 
patched into Bank 1-24 in place of Channels 23 and 
24, performing an Input to Bank > 1-24 operation with 
the default option selected will cause Inputs 1-24 to 
get patched to Channels 1-24 (even though Channels 
23 and 24 are hidden), while leaving Channels 55 and 
56 unchanged. Selecting the current layout option for 
this operation would route Inputs 1-22 to Channels 
1-22, and Inputs 23 and 24 to Channels 55 and 56, while 
leaving Channels 23 and 24 unchanged.

•	 Save As Template 
When saving the current session as a template, you 
are now given the option to overwrite existing tem-
plates from a list of templates.

•	 Card Output Assignments 
Card Output assignments are now reset to the de-
fault when a new session is created using the Empty 
Template. These settings used to be carried over from 
the previously open session, and needed to be reset 
manually if you wanted to create new output routes. 
To create new sessions with preconfigured output 
routing, simply create a new session using the Empty 
Template, configure the output routing as you desire, 
then save the session as a new template.

FIXED OR UPDATED SINCE BUILD 1.01.037
Mix Editor fixes:
•	 Deleting or cutting Automation Nodes no longer sets 

the cut region to –INF gain. Instead, it sets breakpoint 
nodes at the Edit In and Out points and deletes all 
nodes in between.

•	 The Cursor Time display changes to indicate Marker 
times as you drag Event, Locate, Loop, and Edit Mark-
ers within the Time Line.

•	 The Value display now shows the correct values for 
every automatable control when editing Automation 
Nodes with the Pencil Tool.
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•	 Nudge Left and Right now function properly.
•	 In previous versions, the setting of an automated 

control would sometimes not change until after an 
Automation Node was passed during playback. This 
meant that if you relocated the Current Time to a 
position in between Automation Nodes, the control 
would remain set to its last value until the next Node 
was reached. This issue has been fixed so that auto-
mated controls always follow the Automation Track 
regardless of Transport Mode and position.

•	 The state of Aux Send On/Off controls were not being 
updated (graphically) in both the Channel Strip and 
the Auxes dialog during Automation Playback.

•	 Plug-In Automation Tracks now display the name of 
the Plug-In as well as the Plug-In control name. Auto-
mation Tracks for Plug-Ins can now be viewed using 
the Plug-ins menu in the Mix Editor ‘Show’ list.

•	 Automation data is now displayed correctly in the Mix 
Editor when a session containing automation data is 
opened.

Fixes to Channel Linking:
•	 The Solo On/Off and Solo Isolate states now function 

properly for Linked Channels.
•	 All changes made to one Linked Channel are now 

correctly reflected in the other Linked Channel. This 
includes changes made with operations such as Cut/
Paste, Automation, Channel Reset, Channel Preset, 
Modify Levels, Assign Buses, and so forth.

•	 Link options for controls that do not exist within the 
selected Channel pair are now dimmed.

Fixes to Channel Presets:
•	 Loading or previewing a Channel Preset no longer af-

fects the Channel’s Automation Read/Write status.
•	 The Channel Presets dialog now remains open until 

explicitly closed so that you can load as many presets 
as you wish without having to reopen the dialog after 
each load.

•	 Channel Presets now save the Dynamics Key Input, 
Key Frequency, Key Q, and Key On/Off as well as the 
Surround LFE Level, LFE Cutoff, LFE Center, and LFE On/
Off control settings. EQ Presets now remember the 
master EQ On/Off state.

•	 Aux Send Level and Pan controls are now loaded cor-
rectly when the Aux Send Mono/Stereo settings differ 
from when the preset was originally saved.

•	 Closing the Channel Presets dialog with the “X” 
button no longer loads the active preview into the 
channel.

•	 An issue with naming presets has been fixed.
Other Fixes:
•	 Issues with copying the Fader, Mute, Pan, Phase and 

Surround LFE controls using the Copy Filtered function 
have been fixed.

•	 Negative values can now be entered into the numeric 
keypad as you would on a standard calculator (i.e., you 
can type the minus sign (–) before the number).

•	 When using the Digital X Bus as an open-loop MMC 
controller, if you punch out of record using the Play, 
FF/Rewind, or Scrub buttons, the Channel Record Arm 
buttons and the Transport Record button LED now 
correctly indicate when Tracks are in Record or Record 
Ready mode.

•	 MIDI Tempo Map file settings are now saved with the 
session file. If the MIDI Tempo Map file is changed, the 
new file settings are reloaded when the session is re-
opened.

•	 The labels for Aux, Bus, Master, Group, MIDI, and DAW 
channel meters have changed from an absolute num-
bering system (channels 73 through 144), to a relative 
one (A1, A2, etc. for Auxes, and so forth).

•	 When the Time Code Source is set to MTC in the Sync 
Window, the transport now responds to incoming 
MTC full frame messages such that it will follow 
external devices, which are in fast forward, rewind, 
scrub, or shuttle modes. The console also now rejects 
incoming MMC commands present at the designated 
MTC In port (Setup>MIDI).

•	 The Macro Assigns pull-down menus 
(Windows>Setup>Macros) have been reworked to ac-
curately reflect the order and structure of the Main 
Menus and their respective menu items. Consequent-
ly, Macro assignments present in version 1.1 will not 
carry over into version 1.2.

•	 All Dynamics Key and Surround LFE controls are now 
included in Channel Cut/Copy/Paste operations.

•	 All Automation controls have now been moved into 
the Automation window (Windows > Automation), 
which is now fixed (not floating) so that the Touch 
Timeout and Return Time controls line up with the 
control surface V-Pots.

•	 The SRC On/Off settings in the AES Card I/O dialog are 
now visually associated with the inputs instead of the 
outputs.

•	 The Phantom Power, –10 dB Pad, and Gain controls 
normally associated with microphone inputs have 
been removed from the four line inputs of the Mic/
Line 4 Card.

•	 An issue with HUI Pro Tools style meters replacing the 
default audio channel meters after selecting Pro Tools 
DAW Emulation has been fixed.

•	 All fader levels can now be trimmed from –48 to +48 
dB by using the Modify Levels dialog. Previously, you 
could only apply a negative trim to a fader.

•	 Certain naming inconsistencies between menu items 
and the dialogs they open have been reconciled.

•	 The discrepancy between the Oscillator Volume set-
ting and the actual Oscillator output level has been 
fixed, as has the scaling on the Oscillator Frequency 
control.

•	 Numerous labeling issues in the Input/Output win-
dow and individual Card I/O dialogs have been fixed, 
as well as discrepancies between these and the actual 
I/O card hardware labeling. These fixes include fixing 
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the Channel Range label above the Mic/Line 4 card in 
the Input/Output window, and relabeling the “AES/
EBU Out” in the Mix Card dialog to “Digital Out.” 

•	 The Channel Reset and Assigns window Reset com-
mands now act on the same controls in the Assigns 
window.

•	 An issue with the Screen Calibration touch-select in 
the Setup window has been fixed.

•	 The Transport now properly exits Scrub mode when 
you press Play, Stop, Fast Forward, or Rewind.

•	 Channel Names are now centered in their respective 
text displays/scribble strips.

•	 Issues with displaying and saving MIDI Maps with 
more than nine MIDI routes have been fixed.

DXB V1.2 Known Issues:
1.	 The Session file format has been changed in version 

1.2 to improve compatibility between older Session 
files and newer software versions as features and 
functions are added and modified. Version 1.1 files are 
backwards compatible with version 1.2, with only two 
very minor exceptions:

	 •  If Channel 1 is assigned to a Group in a 1.1 session, 
Channel 1 will be de-assigned from the Group(s) when 
opened in version 1.2

	 •  If any of the Bus Channels are themselves assigned 
to Bus 1 in version 1.1, they will be de-assigned from 
Bus 1 when opened in version 1.2

	 Opening and resaving a version 1.1 session file in ver-
sion 1.2 will convert the session file to the newer 1.2 
session file format. While every effort has been made 
to insure that 1.1 sessions are forward compatible with 
the 1.2 format, you should nonetheless back up your 1.1 
session files to a non-working directory before open-
ing and resaving them in version 1.2. 

2.	 Because the structure and ordering of the Macro 
Assigns pull-down menus have changed, Macro as-
signments present in version 1.1 will not carry over 
into version 1.2. If you use Macros, then before you 
install version 1.2 make a note of your current Macro 
settings so that you can recreate them after you in-
stall 1.2.

3.	 The Direct Out routing menus in the Channel Strip 
and Channel Assigns window display the names of 
the physical outputs simply as “Out n” instead of the 
name of the output as shown in the Card I/O dialogs. 
This will be corrected in a future release.

4.	 When Events and Automation are used simultane-
ously, under certain circumstances channel controls 
affected by a given event will momentarily ‘glitch’ 
when the Current Time is located to a position occur-
ring after the event. This happens only when time is 
changed using the mouse or the transport Fast For-
ward/Rewind buttons, but does not happen during 
Automation/Event playback.

Previous Release Notes

RELEASE NOTES FOR BUILD 1.1.037
Build 37 is the first software build for the Digital X Bus 
that supports use of the new FireWire Card. If you have 
purchased the FireWire Card, you must have Build 1.1.037 
loaded on your Digital X Bus.

FIXED OR UPDATED SINCE BUILD 1.01.036
•	 The Solo buttons on the Aux and Bus Master Channel 

Strips can now be used. Even though this solo func-
tion is designed as a Mix Down Mode Solo, activating 
an Aux or Bus Master solo will not illuminate any of 
the other channels’ Mute buttons.

•	 Soloing a linked pair is now possible from pushing 
either the left linked channel or right linked channel’s 
Solo button.

•	 The default state of the Digital Cards upon first boot 
up of the mixer has now been changed to “ADAT” as 
opposed to “TDIF.”

•	 The default state of the “Transport and Track Arming” 
state on the MIDI Layer is now “External MMC Device” 
instead of “DAW.”

•	 An issue with un-doing a plug-in automation pass 
after that plug-in has been deleted from the Effects 
Rack has been fixed.

•	 An application error caused by the over-layering of the 
EQ/Dynamics windows, the Audio Toolbox, and any 
Analog Card I/O Panel(s) has been fixed.

•	 A crashing issue associated with opening a session file 
by double-touching the file name in the Open Session 
dialog has been fixed.

RELEASE NOTES FOR BUILD 1.1.036
This software update for the Digital X Bus is intended 
to flush out and fix several of the remaining MIDI layer 
issues that have been found in recent builds. Significant 
work has also been done to implement the time code 
frame rate features correctly so that the console can now 
slave to SMPTE (LTC) time code at the desired FPS.

FIXED OR UPDATED SINCE BUILD 1.01.030
•	 Much work has gone into the separation of the trans-

port between the MIDI Layer and the way it functions 
as an MMC Controller. There is now a “Transport and 
Track Arming” section in each DAW Emulation GUI 
that has both an “External MMC Device” and “DAW” 
checkbox. This selection will dictate how the transport 
and track arming buttons (REC ASSIGN) interact with 
all external equipment.

•	 The Scrub button LED now turns off when the Trans-
port state is changed.

•	 The Marker Mode is now working correctly in Logic 
Emulation Mode.
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•	 The STOP and PLAY buttons no longer send the “RTZ” 
and/or “Play Last” command.

•	 The Time Line Grid in the Mix Editor now scales cor-
rectly for the supported time code frame rates.

•	 The master REC button now functions correctly in Cu-
base Emulation Mode.

•	 The SMPTE (LTC) 24 and 25 FPS rates are now supported 
correctly, and the console will only lock to the correct 
TC frame rate as specified in the Clock Settings Panel.

•	 The transport LEDs in Cubase Emulation Mode now 
function the same as they do on a Mackie Control Uni-
versal.

•	 The “Select All Faders” now ignores all the MIDI Layer 
channels, as well as Aux Masters and Group Masters.

•	 A minor channel select issue between the MIDI Layer 
and the rest of the console’s channels has been resolved.

•	 All MMC output messages from the console transport 
are now disabled when the “DAW” checkbox is select-
ed under the “Transport and Track Arming” area of the 
MIDI Layer GUI.

•	 An issue with the transport buttons being pressed 
during a playback or record pass of a Cubase session 
have been fixed.

RELEASE NOTES FOR BUILD 1.1.030
This build implements new software support for all the 
recent hardware updates.  You must have all these up-
dates in place to be able to use build 1.1.030.  If you are 
unsure if you have had these updates installed or even 
if your new Digital X bus came with the updates already 
included, please contact the Mackie Technical Support 
Group directly (toll free +1 800.258.6883) to find out 
more.  If you reside outside the United States or Canada, 
make sure to contact your local Mackie rep or dealer to 
check and be sure you have all the updates.

FIXED OR UPDATED SINCE BUILD 1.01.027
•	 The talkback stream now follows the action of the 

TALK button on the console when it is assigned as a 
Channel Input Source.

•	 Aux Mono/Stereo settings are now saved with all Ses-
sion Files and Snapshots.

•	 The Jog/Shuttle Modes for the HUI Layer are now 
functioning properly. There are now separate “Jog” 
and “Shuttle” modes that are activated by multiple 
presses of the SCRUB button on the HUI Layer.

•	 SMPTE output on the Sync Card has been implement-
ed as a SMPTE throughput, getting its source directly 
from the SMPTE input on the Sync Card.

•	 The software build designations have changed from 
“1.01.xxx” to “1.1.xxx”.

RELEASE NOTES FOR BUILD 1.01.027 

SYSTEM FIXES SINCE BUILD 1.01.023
•	 Additional testing and fixes were made to the con-

sole’s virtual memory usage and management. This 
addresses the “Virtual Memory Error” messages that 
were being reported to appear on the screen(s) during 
operation. Even though this was a fix reported in Build 
1.01.023, it was discovered again and required this ad-
ditional fix to be implemented immediately. These 
virtual memory fixes address long-term use of the 
console between re-boots (over 70-80 hrs) as well as 
heavy use of the automation system.

•	 A large number of session files created on both cur-
rent and older versions of the X.200 software were 
used to fix a session recall/opening issue. All session 
files should now open correctly, regardless of the 
software build on which they were originally saved/
stored. This fix was implemented in response to some 
issues encountered with a similar fix that went into 
Build 1.01.023.

•	 Specific console freezes associated with either writing or 
reading automation data have been fixed. This includes 
an intermittent freeze that occurred when writing auto-
mation from the control surface, but with the Mix Editor 
window open. As a result, the overall stability of the au-
tomation system has been improved dramatically.

•	 If switched to 176.4 kHz or 192 kHz sampling rate, 
the console now alerts the user that there are fewer 
inputs to work with to accommodate the higher 
sampling rate. Specifically, the console automatically 
“shuts off” card slots 1-4 and marks those slots in the 
I/O Configuration Panel as “Disabled.” Users who want 
to run the console at 176.4 kHz or 192 kHz will need to 
install their I/O Cards into slots 5-8 and will get a total 
of 32 channels in and out of the console, plus use of 
the Mix Out Card. The console will also disable inputs 
and outputs 1-32 from all software assignment pull-
down menus so there is no confusion as to how the 
console operates at 192kHz.

•	 All console automation support for the MIDI Layer has 
been removed because that layer is intended only to 
provide control for a DAW. You use the MIDI Layer of the 
X.200 to automate your DAW and not the console itself. 
Any automated moves that appear on that layer are 
a direct result of reading automated events that have 
been written (or are being written) to the DAW. This 
greatly simplifies the automation system of the console 
and better optimizes the automation functionality to 
the controls of the console itself, and not the DAW.

•	 When changing the DAW Emulation Mode of the 
X.200, the MIDI Layer now re-initializes itself to 
refresh the communication between the console 
and your Mac/PC. This enhances the ability to use 
the MIDI Layer to control different audio programs 
without having to re-boot the console. This also coun-
teracts some crashing that was resulting from loading 
DAW applications with the console connected. Ad-
ditional measures were taken to improve the overall 
active sensing protocol of the MIDI Layer to further 
stabilize interactivity with a connected DAW.
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FIXED OR UPDATED SINCE BUILD 1.01.023
•	 An issue with soloing and un-soloing grouped chan-

nels along with a group master has been fixed.
•	 The “Launch Executable (.exe)…” selection in the File 

Menu now launches pointers/links (.lnk files) to target 
executables as well as the executables themselves.

•	 The “Faders To Tape” feature has been removed be-
cause of redundancy. Users can activate Fader Swap 
with “Level to Tape” enabled in the V-Strip to perform 
the exact same function.

•	 Channel Read and Write status are no longer stored 
along with Snapshots. This was done to prevent 
accidental over-writing of automation data when re-
calling Snapshots.

•	 All Write Assign buttons are now disabled when 
“Stop” is pressed on the transport. This prevents the 
accidental overwriting of automation events. With the 
Auto Write feature enabled (added in build 1.01.023), it 
is not necessary to keep write-enabling channels for 
each automation pass.

•	 The MIDI Layer has been removed from the console 
Snapshot parameters, such that Snapshots will only 
store and recall parameters of the console itself. The 
reason is that all DAWs can recall the settings of a par-
ticular session file, which in turn saves the positions of 
any controls on a connected control surface. Therefore 
Snapshots that include the MIDI Layer controls are un-
necessary and redundant.

•	 The “Launch Executable (.exe)…” option from the File 
Menu now runs the Universal Audio “.reg” license files 
associated with the UAD-1 Card. This enables UAD-1 
enthusiasts to authorize any desired UAD plug-in 
license(s) for their X.200.

•	 Audio now routes and passes correctly at 176.4 kHz 
and 192 kHz sampling rates.

•	 The Automation Window can now be assigned as a 
Macro button command.

•	 An issue that prevented the re-opening of some Win-
dows after being closed has been fixed.

•	 MIDI Layer fixes:
	 – The MIDI Layer now initializes after Logic starts up.
	 – The REW and FF commands now work correctly with 

Logic.
	 – All controls and messages for 24 channels on the 

console are now showing up and acting correctly; this 
includes the V-Pots, the LED rings around the pots, 
channel names, etc.

	 – The Write Assign buttons now act as track arming 
commands for the entire MIDI Layer; eventually, this 
command will change over to the Rec Assign button, 
but these Write Assign buttons can be used in the 
meantime.

	 – Issues related to using the Cycle Mode feature of the 
MIDI Layer with Logic have been fixed.

	 – Some “sticky button” LEDs associated with the MIDI 
Layer have been fixed.

	 – Zoom Keys with the ALT and OPT modifier com-
mands are now functioning properly.

	 – Jog function on the HUI Layer has been fixed.
	 – SHIFT+Play now functions as “Pause” command with 

Logic.
	 – Channel Select as Touch command now working 

with Logic.
	 – SHIFT+V-Select Mute command now working with 

Logic.

RELEASE NOTES FOR BUILD 1.01.023 

NEW FEATURES SINCE BUILD 1.01.020
•	 New colored Auxiliary level indicators on Main Mixer 

Screen have been changed to reflect status of aux 
sends. Now you can tell from the main screen which 
auxes are on/off, and pre/post….just like the d8b.

•	 Added a new “Touch Sense” button to the automation 
system such that you can shut off the touch sensitivity 
of the faders to prevent accidental automation writing.

•	 Added an “Auto Write” feature based primarily on the 
d8b auto write feature, in which a channel will detect 
any changes being made during a pass, and will put 
itself into Write Mode as a result.

•	 The Automation Window has been redesigned, using 
V-Pot controls for the Touch Timeout and Write Fly-
back Return Time and also incorporating the new auto 
features mentioned above.

•	 A new updated “Digital X Bus” splash screen has been 
added in place of the original “DXB” screen.

FIXED OR UPDATED SINCE BUILD 1.01.020
•	 An issue associated with recalling older session files 

has been fixed.
•	 “Application Not Found” error message after installa-

tion has been fixed.
•	 Footswitches are functioning again.
•	 Sticky button on the Keyboard/Keypad has been fixed.
•	 The Input Assign Menu in the Control Room now 

shows all possible inputs, including the master digital 
inputs (AES or S/PDIF).

•	 Aux sends patched into third party plug-ins are now 
saved and recalled accordingly.

•	 The L/R selection in the Control Room now mutes the 
other sources to the Control Room.

•	 Soloing groups is now working correctly.
•	 Loop Start and Stop points are now stored and re-

called with session files.
•	 Channel Phase function now is automating correctly.
•	 Dynamics VU meter now shows reduction amount 

down from unity, not up from zero.
•	 Red reduction meter in Dynamics Window now only dis-

plays to show reduction amount (as it was originally).
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•	 Master faders are now automating correctly.
•	 Linked channels can now be automated as a linked pair.
•	 Bus assignment to L/R Mix now sums in the proper 

location along the L/R Mix pathway (pre-insert points, 
DSP, mute, and fader).

•	 Channel Preset Window now updates with the select-
ed channel.

•	 Modify Levels Dialog has been updated to show only 
compatible parameters, i.e., those parameters that 
can be modified with a global variation setting.

•	 Control Room Source Selection now overrides all other 
CR source selections.

•	 Oscillator settings now also stored with session files.
•	 Close All Windows function now working properly.
•	 Preset Directories have been moved back to the “D:/” 

partition as the default location; VST plug-in preset 
directories will continue to be where the VST installer 
puts them.

•	 Repaired a memory leak that would display a “Virtual 
Memory Error” message.

•	 Fixed the double-SHIFT select issue on the MIDI Layer.
•	 Master Fader can now be automated.
•	 Automation Window redesigned to include a “Touch 

Sense” and a “Auto Write” function that can be tog-
gled on or off.

•	 SMPTE input has been fixed.

RELEASE NOTES FOR OS INSTALLER 1.1.04 

INSTALLATION NOTES
The main addition in this new OS Installer is the addition 
of Windows Service Pack 2 (SP2) to the Embedded OS of 
the mixer. 
Note: Please refer to the “OS Installer Installation Instruc-
tions” for instructions on how to perform this OS update. 
It must be performed using a USB CD ROM drive.
This OS update provides many fixes related to the op-
eration of the mixer with external USB peripherals, 
such as MIDI interfaces, USB CD ROM drives, etc. This 
installer also puts the latest Digital X Bus software (build 
1.01.020) into the mixer.
Because this OS Installer offers some major operational 
enhancements to the console, it is necessary to perform 
this OS Installation to update to build 1.01.020. You will 
notice that we have not posted build 1.01.020 as a sepa-
rate download for exactly this reason. We will follow up 
this release with more software updates/builds, but all 
will be based on using OS Installer 1.1.04.
Make sure you back up all session files, presets, or any 
other personal files to an external USB Flash drive before 
performing this update, as it will wipe the entire hard 
drive and rebuild the operating system.

FIXED OR UPDATED SINCE BUILD 1.01.018 
or OS 1.00.007
•	 The File Manager can now read and display files that 

are on an attached USB CD ROM drive. This includes 
the ability to read and launch any “Setup.exe” files 
common to almost all third party plug-in installer CDs.

•	 Communication with supported USB MIDI Interfaces 
has been dramatically improved.

•	 The “Double Select” Shortcut that opens the Channel 
EQ and Dynamics section(s) has been re-enabled.

•	 The calibration reference levels points in the Control 
Room Setup Window can be customized.

•	 An issue with the attack setting of the channel compres-
sor filter that created a “doubling” or a perceived delay 
with heavily compressed audio signals has been fixed.

RELEASE NOTES FOR BUILD 1.01.018 

FIXED OR UPDATED SINCE BUILD 1.01.017
•	 The Mackie Final Mix VST has been added as a stan-

dard Digital X Bus plug-in.
•	 STOP and PLAY MMC messages are no longer inhibited 

by the time code setting of the console.
•	 Dynamics (Compressor/Gate) now will display the set-

tings in the graphic display even if disabled.
•	 Mic input trim encoder label is now consistent with 

actual input gain setting shown in the numerical 
reader.

•	 Engaging talkback now activates the DIM for the Con-
trol Room.

•	 Frequency labels have been added to the Channel EQ 
Graphic Display.

•	 The playback timer in the Digital Performer Emulation 
Mode (MIDI Layer) is now functioning.

•	 The hardware SCRUB button now activates the MIDI 
Layer Scrub function, along with the transport.

•	 The correct messages are now being displayed on 
channels 17-24 of the Digital Performer Emulation 
Mode of the MIDI Layer.

•	 The latency of return messages from Digital Performer 
when using the MIDI Layer has been improved.

•	 All surround monitoring labels in the various assign-
ment menus and Control Room output assignments 
are now consistent with each other.

•	 The labeling for the Stereo Delay plug-in Delay setting 
is now in milliseconds (ms).

•	 Cue Sends 1 and 2 have ancillary “Aux 9/10” and “Aux 
11/12” labels in the Aux Window.

•	 SIG LED and channel meter in the Digital Performer 
Emulation Mode of the MIDI Layer are now active.

•	 You can now assign plug-ins across channels in Digital 
Performer using the Digital X Bus MIDI Layer.
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•	 All Channel and DSP preset dialog buttons (found 
in each of the Preset Windows) are now functioning 
properly.

•	 Korean translations for the Digital X Bus software 
have been added to the supported language list in the 
Setup Window.

RELEASE NOTES FOR BUILD 1.01.017 

NEW FEATURES SINCE BUILD 1.0.095
•	 New Stereo Linking feature for all Auxiliary Sends 

such that any aux send on the console can be a mono 
send or part of a stereo pair.

•	 New “Clear Plug-in Automation” selection in the Edit 
Menu.

•	 Implementation of SHIFT, CTRL, and ALT modifiers on 
MCU (Mackie Control Universal) Layer.

•	 New multi-lingual support has been added as an op-
tion in the Setup Window (Windows>Setup>General) 
for the following languages:

	 ◊ Chinese 
◊ Portuguese 
◊ Spanish 
◊ French

FIXED OR UPDATED SINCE BUILD 1.0.095
•	 Improvements to switching Auto Modes for all chan-

nels on HUI Layer, by holding down the Auto Mode 
button on-screen and using the hardware SELECT but-
tons on the channel(s).

•	 Improvements to accessing inserts for all channels 
on HUI Layer, by holding down the Insert button on-
screen and using the hardware SELECT buttons on the 
channel(s).

•	 Transport on the MCU/HUI Layer has been separated 
from that layer and can now be used as the DAW 
transport from any layer (with the “Include Transport” 
checkbox checked).

•	 Addition of the DSP EDIT/ASSIGN view for editing 
plug-ins on HUI Layer; this section acts exactly the 
same way as the VFD plug-in editor on the original 
HUI controller.

•	 The Active Sensing protocol of the MIDI Layer when 
used in HUI Mode has been dramatically improved.

•	 All Mix Out Card labels in I/O Configuration Window 
have been corrected.

•	 Output Assignments in the Control Room, Phones, and 
Talkback have been re-organized.

•	 Delay of talkback microphone input signal to phones or 
channel output has been decreased by a factor of 4x.

•	 Session files not saving and recalling VST plug-in 
patches and settings has been fixed.

•	 Additional protection code has been added to increase 
overall system stability and operation, especially with 
opening/closing session files that have VST plug-ins 
loaded.

•	 “Adjust Channel Delay” function is now calculating 
correctly across multiple channels and instances, even 
with a negative offset.

•	 Floating Insert menus now showing the same output 
names as I/O Panel.

•	 The “Launch 3rd Party Installer” in the File Menu has 
been re-named “Launch Executible (.exe)” for clarity.

•	 SIG LEDs have been removed on the HUI Layer (meters 
remain active).

•	 Snapshots now recall all VST parameters.
•	 Opening/Closing session files with VST plug-ins has 

been dramatically stabilized.
•	 A new boot-up dialog now appears during the boot 

process to confirm to the user the console is booting.
•	 The Calibration reference points in the Control Room 

can now be customized to your liking.
•	 Session files now recall linked channels.
•	 Resetting DSP on one linked channel now is applied 

across the linked pair.
•	 Decimal point entry issue in the Virtual Keypad has 

been fixed.

RELEASE NOTES FOR BUILD 1.0.095 

FIXED OR UPDATED SINCE BUILD 1.0.092
The primary change in this release is the implemen-
tation of a new three-point touch screen calibration 
algorithm, which is intended to increase the Digital X 
Bus’ overall touch sensitivity on both screens. Specifically, 
this new calibration routine improves the accuracy of the 
touch controls along the screen edges and in the screen 
corners considerably.
Also, it is now possible to calibrate one display at a time.  
Therefore, if you find that one screen seems to be react-
ing better or more accurately than the other, then you 
can choose to calibrate only that screen and leave the 
first one alone (or vice versa).
You can go to Windows > Setup > General to see the new 
calibration controls, or perform either of the following 
shortcuts:
CTRL+ALT+SHIFT+Macro #1 = Calibrates the left screen
CTRL+ALT+SHIFT+Macro #2 = Calibrates the right screen
CTRL+ALT+SHIFT+Macro #3 = Sets both screens to the 
factory default
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RELEASE NOTES FOR BUILD 1.0.092 

FIXED OR UPDATED SINCE BUILD 1.0.090
• 	 Improvements made to the “Follow Selected Channel” 

feature in the Mix Editor.
•	 Level Balance pot in the Control Room between Near 

Field and Main has been re-labeled as “Near/Main Bal-
ance.”

•	 Overall improvements to the Control Surface Layer 
(MIDI Button) such as metering, transport activity, 
general MIDI communication, and the controller “pro-
files” as recognized by the computer.

•	 New “3rd Party Installer” function from the File Menu 
now launches any “shortcut” link to an executable 
(.lnk files). This is for running plug-in authorizer apps 
that may be installed to the internal hard drive along 
with the plug-ins.

•	 Footswitches 1 and 2 are now active.
•	 Drivers for the MIDIMAN MIDISPORT USB MIDI Inter-

faces in now included with the Operating System. USB 
MIDI Interfaces now supported and not needing any 
additional driver installation:

	 – USB MidiSport 1x1 
– USB MidiSport 2x2 
– USB MidiSport 2x4 
– USB MidiSport 4x4

	 Other USB MIDI Interface drivers can be installed 
(such as MOTU, Edirol, and ESI interfaces), but the ones 
in this list are supported without additional drivers 
required.

•	 A new DXB OS Image (.iso file), as well as detailed 
instructions of how to use it, is now available for 
download from the Digital X Bus web site. The OS Im-
age file should only be used in order to re-format the 
internal hard drive, or re-load the Operating System 
as well as the build of Digital X Bus software that is 
available at the time of the OS Image creation. The 
current OS Image file is v1.0.006, and it also has DXB 
v1.0.092 bundled with it.

	 NOTE: Please read the instructions before download-
ing and using the OS Image.  It requires a very specific 
process and it must be followed exactly or it will not 
function properly.  You need to back up all sessions, pre-
sets, plug-in installers, and anything else you may have 
saved to your internal hard drive.  You can download and 
create a CD using this OS Image from either a Mac or PC.

	 If you have any questions about using the OS Image 
file, please contact the Mackie Technical Support Team 
at 800.898.3211 (toll free in the USA and Canada) or  
425.487.4333 from outside the USA.

RELEASE NOTES FOR BUILD 1.0.090

FIXED OR UPDATED SINCE BUILD 1.0.088
•	 Virtual encoder graphics updated to match corre-

sponding value on potentiometer.
•	 Mix Editor reaction time and refresh rate improved.
•	 Attached keyboards (USB or PS/2)will function nor-

mally in all text fields.
•	 Channel select in Mix Editor matches hardware select 

buttons, and vice versa.
•	 VST plug-ins now will “reset” to the factory default state.
•	 EQ on/off function now active for automation purposes.
•	 A “Clear Plug-in Automation” function has been added 

to File Menu.
•	 Memory Read Alert Message during shutdown se-

quence resolved.
•	 MIDI Map feature now has separate, user-selectable 

MIDI port assignment.
•	 Auto-Scrolling in Mix Editor now functioning to speci-

fication.
•	 I/O panel graphic for Digital I/O Card now matches 

silkscreen.
•	 Touching any of the four EQ nodes now activates that 

corresponding bandfilter.
•	 Digital Performer overlay text correction – “Save” is 

now “Slave.”
•	 EQ/Dynamics Reset Commands carries through a 

linked pair.
•	 EQ Graphic display scaling/measurement now match-

es value of potentiometer.
•	 Implementation of new “Software Installer” feature 

that runs any executable (.exe) file either attached via 
USB (CD or Flash drives) or from the internal hard drive.

RELEASE NOTES FOR BUILD 1.0.088

INSTALLATION NOTES
This update is a two-part installation procedure that in-
cludes a software update and a system update. It is very 
important that these updates be installed in the appropri-
ate order. First, go to Install Packages in the dXb File Menu 
and install the software update to v1.0.088. Second, re-
turn to Install Packages and install System Update 1.0.01. 
The dXb will reboot upon completion of the updates.

FIXED OR UPDATED SINCE BUILD 1.0.085
•	 Fixed — Selecting channels in the Mix Editor is not 

reflected in the hardware.
•	 Fixed — Snapshot enumeration.
•	 Fixed — Phones volume are Post C/R volume.
•	 Fixed — Must toggle MIDI port/Sync settings to get 

MMC/MTC to work.
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•	 Fixed — Waves C1 plug-ins show up in Setup Dialog.
•	 Fixed — Digital Trim not linked.
•	 Fixed — Aux Pre/Post not automating.
•	 Fixed — Mic/Line 4 not seen by software.
•	 Fixed — No Time/Date stamp in History List.
•	 Fixed — TDIF selection non-functional.
•	 Fixed — Unlock Dialog — Can’t enter text without 

mouse click.
•	 Fixed — Can’t highlight entire track in Mix Editor.
•	 Fixed — On/Off in FX Rack cuts off signal.
•	 Fixed — Waves Authorizer GUI not sized correctly.
•	 Fixed — CR volume taper problem.
•	 Fixed — Have to hit enter twice in Locator.
•	 Fixed — “Save Session As” text entry.
•	 Fixed — Antares challenge/response screen not sized 

correctly.
•	 Fixed — “VST Window Error” message upon deleting 

plug-ins.
•	 Fixed — CRASH when deleting T-Racks Master plug-in
•	 Fixed — SHIFT button stays on when opening saved 

session.
•	 Fixed — Automating sharp fader moves is not work-

ing properly.
•	 Fixed — SMPTE IN is now functioning.
System Update 1.0.01
•	 Installs some system fonts required to resolve the var-

ious VST authorizer window size problems mentioned 
above as well as general UI problems related to these 
missing fonts.

RELEASE NOTES FOR BUILD 1.0.085

FIXED OR UPDATED SINCE BUILD 1.0.079
•	 Fixed — Comp/Gate curves on screen drawing.
•	 Fixed — Dynamics Key Input does not work when fed 

by channel.
•	 Fixed — Virtual Keypad numbers are in the wrong order.
•	 Fixed — Issues with non time-code related numbers 

via virtual number pad.
•	 Fixed —  Session template display error.
•	 Fixed — Onscreen keyboard won’t stay “ON.”
•	 Fixed — MMC Stop and Play not transmitted when 

console is set to Internal.
•	 Fixed — Solo Isolate not saving.
	 Fixed — Create New Session after automation pass 

crash.
•	 Fixed — Reset channel delay crash.
•	 Fixed — Encoders freezing up.
•	 Fixed — MIDI layer not saving.
•	 Fixed — Space bar doesn’t Play/Stop anymore.
•	 Fixed — Enter command not functioning in Locator.
•	 Fixed — Missing text in Link menu.
•	 Fixed — Audio Toolbox (Oscillator) settings are now 

saving with session data.
•	 Fixed — Issues with channel post inserts resolved. 

Post inserts are now functional.
•	 Fixed — Issues with Mix Editor and EQ graphs draw-

ing ‘sluggishly.’
	 Fixed — Issues with Mute/Solo states and session sav-

ing not working.
•	 Fixed — Issue with talkback microphone always being 

on.
•	 Fixed — Issues with VST plug-ins not displaying cor-

rectly on first load.
Additional Features:
•	 Effects Rack plug-in loading/deleting GUI changed to 

accommodate long plug-in names and allow for load-
ing and removal of multiple plug-ins at once.

•	 New VST plug-in scan path has been added  
(D:\FreewareVST).


